


WHAT IS IICA?

The Inter-American Institute for Cooperation on Agriculture (IICA) is the specialized agency for
agriculture of the inter-American system. The Institute was founded on October 7, 1942 when the
Council of Directors of the Pan American Union approved the creation of the Inter-American
Institute of Agricultural Sciences.

IICA was founded as an institution for agricultural rescarch and graduate training in tropical
agriculture. In response to changing needs in the hemisphere, the Institute gradually evolved into
an agency for technical cooperation and institutional strengthening in the field of agriculture. These
changes were officially recognized through the ratification of a new Convention on December 8,
1980. The Institute’s purposes under the new Convention are to encourage, facilitate and support
cooperation among its 33 Mcmber States, so as to better promote agricultural development and
rural well-being.

With its broader and more flexible mandate and a new structure to facilitate direct participation by
the Member States in activities of the Inter-American Board of Agriculture (IABA) and the
Executive Commiittee, the Institute now has a geographic reach that allows it to respond to needs
for technical cooperation in all of its Member States.

The contributions provided by the Member States and the ties IICA maintains with its 17
Permanent Observers and numerous international organizations provide the Institute with channels

to direct its human and financial resources in support of agricultural development throughout the
Americas.

The 1987-1993 Medium Term Plan, the policy document that sets IICA’s priorities, stresses the
reactivation of the agricultural sector as the key to economic growth. In support of this policy, the
Institute is placing special emphasis on the support and promotion of actions to modernize
agricultural technology and strengthen the processes of regional and subregional integration. In
order to attain these goals, the Institute is concentrating its actions on the following five Programs:
Agricultural Policy Analysis and Planning; Technology Generation and Transfer; Organization and
Management for Rural Development; Trade and Integration; and Agricultural Health.

The Member States of IICA are: Antigua and Barbuda, Argentina, Barbados,. Belize, Bolivia,
Brazil, Canada, Chile, Colombia, Costa Rica, Dominica, the Dominican Republic, Ecuador, El
Salvador, Grenada, Guatemala, Guyana, Haiti, Honduras, Jamaica, Mexico, Nicaragua, Panama,
Paraguay, Peru, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Trinidad
and Tobago, the United States of America, Uruguay and Venezuela. The Permanent Observers of
IICA are: Arab Republic of Egypt, Austria, Belgium, European Communities, France, Germany,
Hungary, Israel, Italy, Japan, Kingdom of the Netherlands, Portugal, Republic of Korea, Republic
of Poland, Romania, Russian Federation and Spain.
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1 Imtroduction

HandiSTATUS (Help with World Animal Disease Status) is a database program which
contains information about animal diseases which are important to international trade or human
health. The main sources of information are the FAO/OIE/WHO Animal Health Yearbook,
published by the Food and Agriculture Organization of the United Nations (FAO), and the
International Animal Health Code and World Animal Health, produced by the International
Office of Epizootics (OIE).

1.1  Program Development

The development of this database was initiated in response to requests for information
by animal health personnel in the Caribbean through CARAPHIN, a project of the Inter-
American Institute for Cooperation on Agriculture (IICA) and the Canadian International
Development Agency (CIDA), with support from Agriculture Canada and the University of
Guelph. Work has continued under a hemispheric project of IICA’s Program V: agricultural
health, which aims to promote the safe trade of agricultural products.

The program was developed by Dr. Theresa Bernardo and Mr. Charles Schotman. It was
initially intended to be a source of integrated information particularly suited for persons working
in isolation in small countries; however, it has come into much wider use. At a meeting of the
OIE Working Group for Animal Health Information Systems in Paris in October 1992, it was
recommended that "the OIE and FAO adopt HandiSTATUS as the computerized interface for
information interchange between countries and international organizations."

" The Animal and Plant Health Inspection Service of the United States Department of
Agriculture (USDA/APHIS) and the OIE have committed financing toward the further
development of HandiSTATUS. Additional features to be built into the program include the
ability to display multiple years’ data and to fill out emergency and annual reports to be
forwarded to the appropriate international organizations. In future, there will be a copy updated
daily with reports of new outbreaks, with regular distribution of updated data by diskette or
through telecommunications.

1.2  Technical Content

HandiSTATUS provides information on diseases of sufficient importance to international
trade or human health to be included in the official lists A and B (OIE/FAQO) or C (FAO). It
features maps of the global distribution of listed diseases for each species affected. More
detailed information on distribution is available in text form. In addition to assisting in risk
identification for import/export decisions, it provides access to the OIE’s International Animal
Health Code recommendations for safe importation of products, lists of reference laboratories
and contains formats for veterinary certificates.




The purpose of a database program is not only to make the information available to the
user, but also to make the process of searching for the information as easy as possible, even for
those users minimally familiar with computers. Toward this end, HandiSTATUS has been
designed to make searching for information a relatively painless process. Nevertheless, the
novice user may wish to begin with one of the step-by-step tutorials on the use of
HandiSTATUS.

The following are examples of kinds of information HandiSTATUS is able to supply:

®What is the worldwide distribution of Swine Vesicular Disease?

®What information is required on the Zoo-Sanitary Certificate for Rabbits?

®Which listed viral diseases of cattle have been reported to occur in Country X?

®Which list A diseases can be transmitted by insect vectors?

®Which diseases should be taken into consideration when moving horses from country X to
country Y?

®What is the address of the FAO reference laboratory for Newcastle Disease that serves my
area?

HandiSTATUS can be run on any IBM compatible microcomputer, provided there is
approximately 6 megabytes (Mb) of space available on the hard disk. It has the potential to
significantly improve the quality and timeliness of animal health information to facilitate the safe
international trade of animals and their products.

1.3  Obtaining a Copy of HandiSTATUS

If you wish to obtain a copy of HandiSTATUS or wish to have your name added to the
list of persons to receive updates please send a message to or call:

Dr. Theresa Bernardo

Information Specialist, Program V: Agricultural Health
Hemispheric Project

IICA Headquarters

PO Box 55-2200 Coronado

COSTA RICA

E-mail until Feb. 28th, 1994: TBERNARD@UCRVM2.bitnet

E-mail after March 1st, 1994: IICA-HQ!TBERNARD@tlaloc.iica.ac.cr
Fax: (506) 29-47-41

Tel:  (506) 29-02-22 ext. 2652.

HandiSTATUS usually comes in a compressed form on one 3.5-inch high density diskette

(3.5" HD). If you do not have access to a computer that will read 3.5" HD diskettes, please
provide specifications for your computer’s diskette drive.
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2 Installation
Before you start using HandiSTATUS we must address some preliminaries, such as
installing the program, understanding in general how it works, and learning basic terminology.

2.1 System Requirements

In order to run HandiSTATUS, you must have a computer with the following characteristics:

L IBM-PC compatible, 80286 (or i386 or i486) microprocessor, with at least IMb (2 or
more megabytes is recommended) of RAM memory.

® MS-DOS (or PC-DOS, etc.)
L A hard disk with at least 6 megabytes (Mb) of free space.

L A VGA graphics adapter is required for viewing the distribution maps. For text data no
particular graphics adapter is necessary.

o Note: HandiSTATUS does not currently support mouse input.

2.2 Installing HandiSTATUS

In order to use HandiSTATUS, you must install it on your IBM PC-compatible computer.
You need only install HandiSTATUS once. If HandiSTATUS has already been installed on your
computer, you need not read this section.

You most likely received HandiSTATUS in the form of one diskette of compressed files.
A compressed file is one which has been encoded in order to make it take as little space on the
diskette as possible. Installing the program will uncompress all of the files and store them on
a hard disk. If you have an IBM-PC compatible computer which fits the description above, then
you may -start with the installation process.

2.2.1 Installation Steps

If at any point during the installation process there is an error (i.e., the computer behaves
unexpectedly), then read section 2.2.2 entitled Common Problems During Installation.



Boot your computer, and go to the DOS prompt. (This is the prompt the computer gives
when it is waiting for user input. Normally, it looks like C>.)

Ensure that you have at least 6 Mb of space available on the hard disk. You can check
the amount of available space as follows below. The symbol [Enter] means the carriage
return key.

Type: DIR [Enter]
After listing the files and directories, this will show you how many bytes are free.

This step is ESSENTIAL for the program to function properly! Be sure that the
CONFIG.SYS file in the root directory has the statement FILES=3S§ (or more, if you
will be using HandiSTATUS in conjunction with other programs). If it does not, edit
it so that it does, and re-boot the computer.

Now, insert the HandiSTATUS installation disk into the correct drive. We will assume
that the drive device letter is A:. If your floppy disk drive has a device letter other than
A:, then substitute your device letter where A: appears in the instruction below.

Type: A:install [Enter]

The installation program will create a directory called HS and will copy the files
necessary to run HandiSTATUS into this directory. You can follow the progress of the
installation procedure on the screen. It will also check the amount of available space on
the hard disk and will check the Files statement in CONFIG.SYS.

Once the program has been successfully installed you will see an introductory screen with
the logos of the international organizations that have contributed information to
HandiSTATUS. The screen will then clear, and the menu bar will appear at the top of
the screen. See section 3.2: Overview of HandiSTATUS Operation, to start using
HandiSTATUS. The next time you wish to start HandiSTATUS refer to section 3.1:
Starting the Program. Have fun!

*If the FILES= command in the CONFIG.SYS file has not been set to 35 or more you
will receive a warning message. Press [Enter] to quit the program, then modify the
CONFIG.SYS file as explained in point three above.

2.2.2 Common Installation Problems

Refer to this section if something "goes wrong" during the installation of HandiSTATUS.

If your problem is not covered in one of the paragraphs below, then you may need to contact
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us to resolve it. Please see contact details under section 1.3: Obtaining a Copy of
HandiSTATUS.

Problem:

Solution:

Problem:

Solution:

Problem:

Solutions:

HandiSTATUS hangs the computer when it is run, or results in an error window
(ared window if you have a color screen) containing the message "Error code 4."

Most likely, you have not set the FILES= command in your CONFIG.SYS file
correctly. It should read FILES=3S, or a higher number than 35. You must re-
boot the computer after changing this line in your CONFIG.SYS file. If, after
making sure that the line is correct, and re-booting your computer, the problem
persists, try changing the number 35 to 45, or 50. If the problem is still present,
contact us.

HandiSTATUS does not run, and you get a "File not Found" error.

The current "Install” program is very simple. It does not recognize errors in
unpacking the compressed program from the installation disk. It may be that the
program did not install correctly. To check if this is the case, go to the DOS
prompt and type: C:\ [Enter] CD \HS [Enter] DIR [Enter]. The screen
should scroll by, and you should get a message that says there are about 115 files
taking up approximately 5.5 million bytes (if you installed all the languages). If
this is not the case, then call us; your installation disk may be damaged, or you
may have a system which requires that special steps be taken.

HandiSTATUS does not run, and you get a message which says something about
too little memory, or low memory, or memory full, etc.

1. It is possible that your system does not have enough memory to run
HandiSTATUS. If you do not have at least IMb of RAM, then
HandiSTATUS will not run.

2. You may have programs in memory which are taking up a lot of memory
that HandiSTATUS needs. If you have large memory-resident programs,
you may need to remove them from memory before running
HandiSTATUS.

3. You may not have an appropriate memory manager installed. If you have
a lot of memory, and have an 80286 or i386 microprocessor, then you
may not be taking advantage of your memory. Check to see if you are
running an extended and/or expanded memory manager, and that it is
operational and configured correctly for your system.




Problem: Since I installed the new DOS 6, my computer locks up or hangs when trying to
run HandiSTATUS.

Solution: 1. In the CONFIG.SYS file in the root directory of the boot disk change the
line EMM386.EXE to DEVICE=C:\DOS\EMM386.EXE RAM auto.

2. Run MEMMAKER and specify that EMS is required by the software
programs.

3 Using HandiSTATUS

3.1  Starting the Program

The first thing you need to do to run HandiSTATUS is change to the directory it resides
in, and execute the program. This is done as follows, assuming that it resides in drive C,
directory \HS:

Type: C:\ [Enter]
CD \HS [Enter]
HS [Eater]

You will see an introductory screen which shows the logos of the international
organizations that have contributed information to HandiSTATUS. The screen will then clear,
and a message will appear while the program loads the data necessary for operation. The screen
will clear again, and the menu bar will appear at the top of the screen.

3.1.1 Enabling the Edit Version

If you wish to use HandiSTATUS to edit (modify) its own data, then you need to supply
the correct password when you run the program. For example, if the password is Xyzzy, then
instead of simply typing H8 to run the program, you would type H8 XY33Y (character case
does not matter within the password). The password is provided under selected circumstances.
3.2 Overview of HandiSTATUS Operation

HandiSTATUS works with a menu-driven system which is easy to use and does not
require any special computer knowledge to operate. At the most general level of control, you

may select one of the seven pull-down menus in the menu bar:

Select View Print Import/Export Utilities Quit Edit
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[ The Edit item will only appear if the editable version of HandiSTATUS has been loaded
(see 3.1.1 Enabling the Edit Version).

’ Notice that the first letter of every item is in emphasized type (on color monitors, it is
in a different color than the rest of the text). These letters corresponding to the menu items are
called the hot-keys. Almost every menu item in HandiSTATUS has a corresponding hot-key.
[ In addition, in some menus there is a key specified in square brackets to the right of the menu

item. These are short-cut keys which can be used without referring to the menu (actually they
do not work within the menu) and are particularly useful in browse lists.

To select a menu item, you may either press the corresponding hot-key, or use the arrow
keys (1, ¥, -», <) to move the cursor (which is highlighted, appearing as a different color than
the other menu items on a color screen) so that the desired menu item is highlighted, and press
[Enter].

To eliminate an unwanted menu, or to exit from the current operation, the "Escape” key
[Esc] is generally used. Pressing [Esc] has the effect of canceling any changes made at the
current level, and returning to the function you were using previously. Thus, in general, to
select a menu item or menu, [Eater] is used, and to exit from a menu or operation, [Esc] is
used. [Enter] generally means "accept” or go on, and [Esc] generally means "cancel” or go
back.

On-line help will be available in future versions of HandiSTATUS by pressing the F1
key. {At present, help is not available for every item at all levels of HandiSTATUS.}

What HandiSTATUS does is search through a collection of records in a collection of
large databases. A record is a structure that holds a number of pieces of data (fields) relating
to the same object. During a search, the program compares records in various databases cross-
referenced with each other, and selects a number of records whose fields contain data which
match the search criteria selected by you.

Throughout this manual, the terms current selection and current disease will be used.
A current selection is a list of diseases (records) which have been selected according to certain
criteria. A current disease is a specific disease (record) within the current selection which you
are focusing your attention on at the present moment. You can check the name of the current
disease by choosing the item Names under View. It is important to keep in mind that most
HandiSTATUS operations involve building a current selection according to your needs, and then
focusing on specific diseases within the current selection to get more detailed information.




3.3 Conventions
Throughout the manual, the following abbreviations for special keys will be used:

[Enter] Carriage Return

[Esc] Escape

[Del] Delete

[Ins] Insert

t, ¢, -, « The arrow keys (« is not to be confused with the backspace key)
[BS] Backspace

(PgUp] Page Up
[PgDn] Page Down
[Home) Home
[(End] End

References to text which appears on the screen will be set in this type style.

Images of actual menus and windows will be set in this type style.

Special terms which should be remembered will be set in this type style.

Characters which you should type (except the special keys listed above) will be set in
this type style.

When referring to the menu systems, we will often wish to refer to a sequence of menus.
For example, we may wish to express the operation of selecting the Select menu, then from that
menu selecting the Diseases option, then from the sub-menu which is activated, selecting the
Group Selection option. This entire sequence would be abbreviated by separating the menu
names and options by forward slashes, thus: Select / Diseases / Group Selection.

The next section of the manual contains tutorials for a quick, practical introduction to the
use of HandiSTATUS. The tutorials are recommended for novice users. A more formal
reference section on the operation of HandiSTATUS (including the entire menu system) is found
after the tutorials. '

4 Tutorials

Tutorial A: Select a Disease and View Information

Before starting this tutorial, you should have successfully loaded HandiSTATUS on your
computer (Chapter 2: Installation) and you should be familiar with Chapter 3: Using
HandiSTATUS.
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Assuming that HandiSTATUS has been installed in drive C, directory \HS, start the
program as follows.

Type: Cs\ [Enter]
CD \HS8 [Enter]
HS [Enter]

HandiSTATUS works with a menu-driven system which is easy to use and does not
require any special computer knowledge to operate. Remember that required items can be
highlighted by using the arrows or cursor keys, and the highlighted item can be activated by
pressing the carriage return key, [Enter]. Menu items can also be chosen by typing the
character of the menu item which appears in emphasized type. In general, press [Enter] to
accept or proceed, and press [Esc] to cancel or go back.

When the program is started, the user can choose one of the items from the main menu

bar appearing at the top of the screen:

Select View Print Import/Export Utilities Quit

A.1  Select the Language of Operation

HandiSTATUS will operate in English, French or Spanish. If you wish to change the
language, move the highlighted portion of the main menu bar (at the top of the screen) to the
Utilities item, using <« and -, and press [Enter]. At this point, a pull-down menu will appear.
The Utilities / Language: change default option will be highlighted. Press [Enter] again, then
use the arrow keys to highlight the language you prefer and press [Enter] once more.

It is assumed that you have installed all three of the language modules; otherwise, the
program will prompt you to do so at this time, using the distribution diskette.

A.2 Select an Individual Disease

We will start with a simple example of selecting an individual disease and viewing some
of the information available about that disease.




Move the highlighted portion of the main menu bar to Select, and press [Enter]. The
Diseases option will be highlighted. Press [Enter], then choose the item Individual disease by
pressing [Enter] once more.

For the remainder of this tutorial, instructions for menu selections will be given in a
more concise form. For example, the above would be represented by: Choose Select / Diseases
/ Individual disease.

You will now be presented with a list of disease names (English, French, Spanish and
scientific names plus synonyms) which are included in HandiSTATUS. Use the down-arrow key
to start scrolling through the list. You can hold this key down to move through the list,
however, it is possible to make a selection more quickly using the incremental search
mechanism.

Incremental search means that the searching process proceeds as you type the name of
the item you are searching for. For example, if you wish to locate African Swine Fever, simply
start typing the name: A, P, etc. Notice that the characters you type appear in the window at
the bottom of the screen after the message Enter disease name: and at the same time, the cursor
moves through the disease list to seek words which match as closely as possible the characters
you have typed so far.

Select View Print I Ef el 8.9 it..E1L.0 3.1
i

Diseases E&

(Y

Re| Press (F2) for menu

Pr Name Code
African horse sickness All0
African pig disease : Al20
African swine fever , Al20
Agalaxia contagiosa B154
Agalaxie contagieuse B154

i American foul brood : B452

i American trypanosomiasis (T. cruzi) B113

= Anaplasma marginale B101

i1 Anaplasmosis B101

Eﬁ Anaplasmosis B101

i Anaplasmosis B101

i Anemia infecciosa equina B205 |

g% Enter disease name: af_
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After you have typed only the first two characters, the program will have matched your
entry against the word African. Deleting characters (by pressing [BS]) backtracks through the
list. You can continue typing the disease name or use the cursor keys to highlight the disease
you wish to select, then press [Enter] to select it.

After making your selection, you will be immediately taken to the View item on the main
menu bar and the names for the disease you selected will be displayed.

A.3 View Information on a Selected Disease

View allows you to see the information available on the disease you selected. The
window on the screen displays the English, French, and Spanish names for the disease and the
scientific name of the causal organism. Across the top of the window from left to right you see
that only one record has been selected, that the disease Code is A120, that the causal organism
is a virus, that the incubation period is 42 days, that the disease can be transmitted by insect
vectors, it is not a zoonosis and the information from the OIE International Animal Health Code
is available in the program. Press [Enter] to see all of the options available under View.
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The information we just saw is available under the Names selection. Let us go on to
display the OIE International Animal Health Code. Highlight the corresponding option in the
View menu and press [Enter] (alternatively, use the hot-key I). A message telling you that text
is being read from disk briefly appears, and then the screen is filled with a window of text from
the International Animal Health Code for the current disease. You may now read the text at
your leisure, and move up and down the document with the up- and down-arrow keys, and the
[PgUp] and [PgDn] keys. It includes information such as definitions of an infected country or
free zone, and suggested requirements for importing from a free country or an infected country.
When you have finished looking at the Code, press [Esc] to return to the View menu.

Press [Enter] to pull down the options under View and select Affected Species and
Commodities. This list of animal species and commodities that can transmit the current disease
(in this case African Swine Fever) is a key factor in the ImportyExport Analysis, which is the
subject of Tutorial B.

Press [Enter] twice to return to the options under View and select Vectors and
Transmission. Here you will find references and information regarding transmission, survival
and inactivation of the causal organism for the current selection. This information was kindly
provided by the Australian Quarantine and Inspection Service. Again, you may go through the
text with the up- and down-arrow keys, and the [PgUp] and [PgDn] keys. Once you have
finished, press [Esc] to return to the View menu and press [Enter] to see the options.

We will now look at some of the options which relate to geographic distribution of the
selected disease. Select Maps / World. You should now see a map of the world distribution
of. African Swine Fever. The legend is as follows:

® the disease has been reported in this species in this country

o the disease has not been reported in this species in this country
? the disease is of questionable occurrence in this country

# the disease is restricted to a specific area within the country

In Tutorial C we will look at how the different OIE/FAO codes for reporting disease
occurrence were divided into these four categories.

Select Borders to draw in the country borders. Once this is finished, select Region to
look at a specific region. This brings a square onto the screen which can be moved with the
cursor to the desired region. Move the square to Africa, then press [Enter] to see the regional
map.

The map of Africa is shown with the borders drawn. You may remove them by selecting
the item Borders, which functions as a toggle. Select Country names (also a toggle). The
countries for which there is no symbol at all (for example Libya, Western Sahara, Senegal,
Togo, etc.) are countries which did not report for this disease in this year.

12

| W | [ W | | W] | W | [ S [ ] | S | W | | W—

) S |



The actual disease occurrence and discase control information reported to the OIE and
FAO, and summarized in the Animal Health Yearbook and World Animal Health (on which the
maps are based), can be viewed by pressing [Esc] to return to the View menu and selecting
Browse Distribution Listing.

Select View Print Import/Export Utilities Quit Ed| 08/26/93 | 14

(F2) - Activate Menu
Disease: African swine fever

= COUNTRY SPECIFIC REMARKS (if any)

Data for 1990

Country Species Occur Control methods
Algeria Su1 - 0000

Angola SUI ++ ) ( P PnQ Qis *
Benin suUrI +.. hd

Botswana SuI - 1987 P Qis »*
Burkina Faso SUI -

Burundi sSul1 + QS *
Cameroon SuI ++ Qis *

Cape Verde SuUI ?

Central African Repu SuUl - 0000

Chad SuI e

v symbols for distribution and control for all countries and species

Here you will see a list of all countries (organized in alphabetical order for each region)
and the information they reported for African Swine Fever. You can move through the list of
countries using the up- and down-arrow keys, and the [PgUp) and [PgDn] keys. If you are not
familiar with the OIE/FAO codes for disease occurrence or disease control, you can press F2
to activate the menu, then select Occurrence Symbols for an explanation of the symbols used.
You can scroll down through the symbols with the arrow keys. Press [Esc] or [Enter] to leave
the list of symbols. The short-cut key, F3, allows you to display the disease occurrence symbols
directly from the list of countries, without using the menu.

Disease occurrence
Symbol  Meaning

0000 Never reported

- Not reported

year Year of last occurrence

? Suspected but not confirmed
(+) Exceptional occurrence

Esc: Exit; R:Re-size/Move Window

From this same menu you can select Search Country (short-cut key Alt-s) which
allows you to jump to a specific country of your choice using an incremental search. Simply
begin typing the name of the country you wish to select and the characters you type will appear
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in the window at the bottom of the screen after the message Seek:. Type IT to select Italy and
press [Enter]. If there is a specific message for the highlighted country and species it appears

in the box "Country Specific Remarks.” The short-cut key Al1t-S can only be used while you
are browsing the distribution listing.

't View Print Import/Export Utilities Quit Ed| 08/26/93 | 14

131

i

File Edit (F2]) - Activate Menu %
Disease: African swine fever i
= COUNTRY SPECIFIC REMARKS (if any) i
i

%s

it

i

— Country name Isocode #
— FiH

= Italy IT i
Ivory Coast CI i

Jamaica JIM #

Japan JP i

Jersey Js i

Johnston Island JT g

Jordan Jo i
Kampuchea, Democratic KH i

Kenya KE &

Seek: it_ i

8
22
i

This has been a brief introduction to a few of the major features of the program. By
now, you should feel comfortable enough to explore the other options by trying them out. To
exit the program, press [Esc] a sufficient number of times to return to the main menu bar.
Highlight Quit, select one of the two options and press [Enter]. The short-cut key to quit
directly from any level is Al1t-Q. Tutorial B provides an introduction to Import/Export
Analysis and Tutorial C- explains how to build and modify a current selection, which is
composed of several diseases. The Reference Sectlon of the manual provides more
comprehensive coverage of all menu items.

Tutorial B: Import/Export Analysis

This tutorial deals with the most specialized feature of the HandiSTATUS program,
which integrates several of the program’s capabilities.

In Import/Export analysis, HandiSTATUS searches for records in a disease database that
match country and commodity data, provided by you, the user. For example, you might have
a client who wishes to import into Mexico a shipment of beef from Venezuela. You would be
interested to know the comparative status of bovine diseases in the two countries, particularly
for those diseases which could be transmitted through beef. This is a simple process using
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HandiSTATUS. All you need to do is specify the exporting and importing countries, and the
species and commodity to be imported.

The HandiSTATUS program would then select the records for all bovine diseases which
can be transmitted through beef, excluding those which have been reported not to occur in
Venezuela. It would present a list of these diseases and the reported occurrence status in the
exporting country (Venezuela) alongside the occurrence status in the importing country
(Mexico). The user can then employ the comparative disease status as an aid in making a
decision about the importation.

It is important to remember that the occurrence status for a given country was reported
by the country itself and was current at the time of reporting. Check your copy of
HandiSTATUS (opening screen or Select/Program Information) to verify the date of reporting.
Eventually, it is envisaged that HandiSTATUS will be updated each day with status changes
reported by the countries. Updated information will be distributed through telecommunications
or on diskette. However, in all cases disease status should be verified directly with the country
concerned.

Let us start our search as specified in the example above. To repeat, we wish to know
which diseases should be considered in a shipment of beef from Venezuela to Mexico. The first
thing we need to do is start the Import/Export Analysis process. To do this, we move the
highlighted portion of the main menu bar (at the top of the screen) to the Import/Export item,
using <« and —». As you move the cursor, you will notice that the line at the bottom of the
screen (the summary line) changes. This line contains a brief summary of the function served
by the highlighted option.

When the Import/Export option is highlighted, press [Enter]. At this point, a pull-down
menu will appear. The Import/Export Analysis option will be highlighted. Press [Enter] once
more. You will be presented with two windows: The top one contains a short description of
the function you have selected (just to remind you), and the lower one contains another menu,
with the top option highlighted. The screen should look similar to the one below.

You need to choose the proper information to enter for the four menu items. First, we
will specify an animal species. Move the cursor using * and ¢ to highlight the Animal Species
selection, and press [Enter]. You will be presented with a menu containing all of the animal
species which HandiSTATUS recognizes. To the left of each species or species group name is
a number or letter: the hot-key for that item. You may select a species either by using * and
¢+ and pressing [Enter] when the desired species is highlighted, or by merely pressing the hot-
key corresponding to the particular item. We wish to get information regarding beef, so we
need to select Bovine (hot key: a). Again, either use ¢ and ¢ and [Enter], or merely press the
hot-key (a). The Species menu will disappear, and you will be returned to the Selection
Criteria menu, with the selection (Bovine) printed next to the Species label, and the cursor
advanced to the next selection criterion, Commeodity Type.
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i | ASSESSMENT OF QUARANTINE RISK ASSOCIATED WITH SPECIFIED
CONSIGNMENT

i Analysis of data based on disease occurrence, species and
i#| commodity range.

i Data Entry for Analysis i#
] i
§§ Animal species %
i Commodity Type #
i Country of Origin &
i Importing country i
i O.K. CLEAR EXIT (Esc) B
i i

Press [Enter], and you will be presented with a Commodity selection menu. Again,
there are hot keys for every commodity type. We need fresh meat (i.e., beef), which is
selection £. Select this item just as you selected Bovine previously, and you will be returned
to the selection criteria menu, with the Country of Origin menu item highlighted. Press
[Enter].

The selection menu this time is rather large, so it is contained in a scrolling window.
Scrolling is simply moving the contents of the window so that previously hidden information
becomes visible. Press ¢ about fifteen times. Notice that when you reach the bottom of the
window, the list of countries scrolls up one line. You may return to the top of the list (where
you started) by pressing * until you may no longer move up. The [PgUp] and [PgDn] keys
may be used to move one window-full of entries at a time.

This scrolling window has two columns: Country name, and Isocode (International
Standards Organization code). To move to the ISOcode column, press - once. To move back
to the Country name column, press <« once. The ISO code is useful for reference purposes,
but also comes in handy when using a feature called incremental search. Suppose, for example,
that you know that the ISO code for Venezuela is VE. Then, to search for Venezuela, instead
of using the arrow keys, you may move the cursor to the ISO Code column and type the
characters VE. Notice that the characters appear at the bottom of the window, and the window
automatically scrolls to the location in the list where the entry for Venezuela is located. Now,
press [BS] once. The E you typed earlier is erased, and the window scrolls up to the entry for
Saint Vincent and the Grenadines. Why is this? Notice that pressing * once scrolls the
window to the previous entry in the list, Uruguay, which has ISO Code UY. The answer to
the question "Why?" is that Saint Vincent and the Grenadines is the first country in the list
whose ISO Code starts with a V. Now, type the letter N. Notice that the cursor is now on the
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entry for Vietnam, because you have entered the ISO Code VN, standing for Vietnam. You may
wish to experiment a little bit now, by using [BS] and trying various ISO codes.

~ Experimentation becomes much more inferesting when you move the cursor to the
Country name column. Do so. Now, say that you wish to select the country Rwanda. Make
sure that you delete all characters already typed (by pressing [BS] a few times), and type the
characters RW. Since Rwanda is the only country whose name starts with the characters RW,
you have made a match in only two characters!

For now, though, we are selecting the country Venezuela. So, backspace over the
characters RW, and type the letters VE. Again, Venezuela is the only country whose beginning
matches our input, so the desired match has been made. Press [Enter] to select Venezuela. The
country selection disappears, and you are returned to the Selection criteria menu. Follow the
same process to select Mexico as the Importing Country (type the letters MEX and press
[Enter]. At this point, you have several options. You may redo any of your four selection
criteria by moving the cursor back to that item in the menu and pressing [Enter], or you may
clear all your selection and start over by moving the cursor to the Clear "button" (a button is
a menu item which is surrounded by an outline to look like a button) and pressing [Enter]; or
you may exit the entire Import/Export Analysis process by "pressing” the Exit "button;" or,
finally, you may accept the current selection criteria by pushing the O.K. "button.” This is in
fact what we wish to do. Move the cursor to the O.K. button and press [Enter].

Two windows appear. The top one is a message informing you that a search is taking
place; the bottom one is meant to keep you informed of the progress of the search by counting
the number of records selected. When the search is over, the progress windows are removed,
and a window appears containing a summary of all the quarantine risk information found with
our search. In our system, there are four selected records (due to the dynamic nature of the
database, the selection on your system may differ). The screen appears as follows:
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This is a list of the diseases which might be of concern when importing beef from
Venezuela to Mexico. The summary window contains, from left to right: the OIE code for the
disease, the common disease name, the disease occurrence code that was reported by the country
of origin (Venezuela) and the disease occurrence code reported by the country of destination
(Mexico). These codes appear in Tutorial C and are also explained in section 7.7, View /
Maps, of this manual.

You have now finished the Import/Export Analysis process, and HandiSTATUS will
remember the groups of records you have selected as the current selection. The Import/Export
option is only one way to make a current selection. The selection just made may now be used
in other features of the program. It remains current until another selection is explicitly made.

You may now do several things:

1. Perform another Import/Export Analysis (if you would like to make a selection based on
different criteria) by pressing [Esc].

2. Exit from the Import/Export options by pressing [Esc] twice.

3. View more detailed information about a specific disease (or specific diseases) in the
current selection by pressing [Enter] while the cursor is on one of the fields in the
desired record in the summary window.

For purposes of this tutorial, we will now select option 3. Move the cursor to one of the
fields for the first record (for Foot and Mouth Disease) and press [Enter]. The screen clears,
and you are presented with a window showing detailed information about the disease:

—~Record=—-=Cod ype=Incubation=Transmission=Zo00nosis=%00~-Code=-

1/ S A010 v 21 days + - +
Causal Organism
Picornaviridae aphthovirus (RNA)
Common Names
English: Foot-and-mouth disease (FMD)
English: Foot and mouth disease
Frangais: Fiévre aphteuse (FA)
Espafiol: Fiebre aftosa (FA)

This is just some of the information we may view about Foot-and-Mouth Disease. Let
us review the various other sorts of information that can be viewed about specific diseases. To
do this, we need to pull down the View menu. At this point, you may feel comfortable enough
with the program to explore the View options on your own, or with the aid of Chapter 7 of this
manual. Tutorial C explains how to build and modify a current selection, which is composed
of several diseases.
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Tutorial C: General Disease Selection

Tutorial A demonstrated how to select a single disease and view the information on that
disease contained in HandiSTATUS. In Tutorial B, we made a very specialized selection of
diseases through the Import/Export Analysis function. This tutorial explains how you can select
a group of diseases from the Select / Diseases / Group Selection menu.

You can make selections based on various classifications, such as type of causal organism
or species affected, and you can modify that selection by adding to it, deleting from it, etc. For
example, you may only be interested in diseases of swine, or you may have a special interest
in hemoparasites. You may even wish to combine criteria to know which bovine diseases are
also zoonoses, or to see if any of the list A diseases which affect sheep have been reported to
occur in Australia.

C.1 Selecting Diseases by Criteria

We wish to begin with the Select menu. To do this, you need to be able to move the
highlighted cursor with the left and right arrows through the options in the main menu bar. If
you are not at this stage, then press [Esc] a sufficient amount of times to return to the main
menu bar. Now, choose Select / Diseases / Group Selection.

Select View Print In

Diseases
(Ye
Rep| Individual dit
~Pro| Group selectic

We now want to build a current selection, composed of several diseases. After selecting
the Group Selection option, one of two things may happen. You may be presented with the
following box titled SELECTION METHOD, which is where we wish to start.

Sel«

Dis¢
(YF
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Or, if for some reason there is already a current selection in memory, then you will be
presented with the following window:

Select

Disease:!
(Year)
Report
Progra

If you are presented with this window, move the cursor to highlight Modify list and press
[Enter]. Then select New list by pressing [Enter] and you will be returned to the SELECTION
METHOD box (above), which is our starting point for this exercise.

The SELECTION METHOD box lists all of the criteria which you can use to make or
modify a selection of diseases. First, we wish to select all list A diseases. Select Status
(A,B,C) / list A. You will see a list of selected diseases. Notice that the main selection was
list A diseases and that 27 records were chosen. Press [Enter] once again to Use list. The
cursor drops down into the list of selected diseases and you can move through the list with the
up and down arrows. Move down through the list until Rinderpest is highlighted and press
[Enter]. You will immediately be taken to the View menu, with the Names of the current
disease displayed. Press [Enter] again to pull down all of the options available under View.

You can now view any of the information available in HandiSTATUS about the current
disease (Rinderpest). Highlight Status and press [Enter] to read the definition of a list A
disease. Press [Enter] twice more to return to the options under View.

C.2 Changing the Current Disease

Our current selection consists of all list A diseases and our current disease is Rinderpest.
We can view any of the information on Rinderpest while it is the current disease, but we can
also change the current disease to any of the other diseases in the current selection (any other
list A disease in this example). From the View menu, select the option List of Selected
Diseases, either using the arrow keys and [Enter], or the hot-key L. You are returned to the
window containing all the diseases in the current selection. Press [Enter] to Use list and you
may now move the cursor to the disease you wish to examine (move to Rift Valley Fever), and
press [Enter] to select it.

Again you will find that you are at the View menu, with the Names of the current disease
displayed. There is an easy and fast alternative way to change the current disease from within
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items in the View menu. Simply use the up and down arrows to go backwards and forwards
through the list; it works when the last selection from the View menu was Names. Try it.
Press the down arrow twice and you will see the names for African horse sickness. Stop here
and press [Enter]. You can now look at any of the other information on African Horse
Sickness.

C.3 Modifying the Current Selection

You now know how to select a group of diseases using one of the criteria specified in
the SELECTION METHOD box. We will now look at ways to modify the current selection
using combinations of criteria.

Press [Esc] a sufficient number of times to return to the main menu bar then choose
Select / Diseases / Group selection. You will see the List of selected diseases window. Select
Modify list and you will see the five choices below.

s.l.ct view Print I:l:l:‘ E:Emmg; ;:gnnn. g%&:::x:xgr ;2 m:%! é‘!%:ﬂln:]t:::!’lngnzzg"
i
Diseases &
Year .
Report List of selc.__:d d: —
Progra Use list New list Modify list Other
- #|Main selection Select from list (F3)
Add to list [Alt-I) =
Record Name Delete from list [Alt-D])

Insert individual disease(s) [Ins]) —

1 Fiebre aftosa (FA| Remove individual disease(s) ([Del)

2 FA - Virus O -

3 FA - Virus A AO12

4 FA - Virus C AO013

S FA - Virus SAT 1 AO14

6 FA - Virus SAT 2 AO015 [—
7 FA - Virus SAT 3 AOlé

Select Add to list and you will be returned to the SELECTION METHOD box. We

are going to add to our current selection all of the list B diseases, so choose Status (A,B,C) /
list B.

The List of selected diseases window now shows that you have added list B diseases to
the current selection for a total of 122 records (see below).

We now wish to select from the current selection only those diseases which are caused
by viruses. Choose Modify list / Select fromn list / Type of disease organism / VIRUS. You
will see that we have decreased the number of records to 65.
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Select View Print Ij ' 2 ) ... Quit.. B1l.9 (27/93.1.18:9
i

Diseases §
(Year) & —
Report _.st of selc__2d A:__. —
Progra Use list New list Modify list Other
................. i# |Main selection : List A diseases 27 records
i Added to above : List B diseases 122 records
i
gg Record Name Code
iiit —
§§ 1 Foot-and-mouth disease (FMD) A010
i 2 FMD - Virus O AO11
i 3 FMD - Virus A A012
i 4 FMD - Virus C A013
%g S FMD - Virus SAT 1 A014 |
i 6 FMD - Virus SAT 2 AO015 |
i -

Now we wish to limit our selection to diseases that occur in horses. Select Modify list
/ Select from list / Species/Commodity and you will be presented with a list of species to
choose from. This is the same list that was used for Import/Export Analysis and functions in
the same way. Select Equine and then select live animals from the list of commodities. You
will see that the List of selected diseases will be reduced to 14 records for viral diseases of
horses that are in either list A or B. You can stop at any time and browse through the list or
look at the information available for a particular disease.

Next we wish to restrict the current selection to those diseases which have been reported
to occur in Spain. This can be done by selecting from the current selection only those diseases
which have been reported to occur in Spain. Another way to do this would be to delete from
the current selection those diseases which have been reported not to occur in Spain. The latter
operation may be preferable in case Spain has not reported for all diseases. It would ensure that
only diseases which have been reported not to occur would be eliminated from the current
selection.

Select Modify list / Delete from list / Country or Region. You will be presented with
an incremental search for countries or regions. Type 8P to highlight Spain and press [Enter].
You are now faced with a complicated-looking, full-screen menu (see below). Take some time
to examine this screen. It includes all of the disease occurrence codes, divided into four
categories. These are the same divisions that are used to draw the maps of geographic
distribution. For example, all countries that had reported one of the codes under category 2
(questionable) would appear with a question mark on the maps.

For our present purposes, this is used to filter our current selection according to the
occurrence of the disease in a specific country. The four principal categories of occurrence are
indicated by the numerals 1 to 4: Reported; Questionable; Confined to Certain Regions; and Not
Reported. Pressing [Enter] while one of these options is highlighted will check all of the sub-
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categories (indicated by lower case letters) of the main categories. Pressing [Enter] again will
remove the check marks (ie., [Enter] functions as a toggle). Pressing [Enter] while one of the
sub-categories is highlighted will either remove or put a check mark (v) next to that sub-
category. The checked items will be used to filter the list, search or display in which you are
currently engaged.

s.l.Ct viw Print Im@ luug 323 “xmxunxmm“ 3:% mr' 200 222229 %itt!! !!!E !!1!!!2!' "!3!!2!!21:!!2%5
1 i B R e et
Dis 'ilter on
[Ye Symbols Disease Occurrence
Rep REPORTED
Pro a. )( Ubiquitous
e b. +++ High occurrence
it Cc. ++ Enzootic
d. + Low sporadic occurrence
e. (+) Exceptional occurrence
f. +.. Disease exists; distribution and occurrence unknown
g. ! Recognized in country for the first time
2 QUESTIONABLE
h. 2 Suspected but not confirmed
i. +2 Serological evidence only, no clinical disease
j. <= Only in imported animals (quarantine)
k. ... No information available (excluding blank records)
3. () CONFINED TO CERTAIN REGIONS
4. NOT REPORTED
1. - Not reported
m. 0000V Never reported
n. year/ Year of last occurrence
O: O.K.

Set. the filter as illustrated above so that only the items under category 4, NOT
REPORTED, have check marks next to them. This means that all diseases which have been
reported not to occur in Spain will be deleted from our current selection. Press O, for O.K.,
to proceed. You will see that our current selection has been reduced to two diseases. Finally,
we wish to know if either of these diseases can be transmitted by insect vectors. Select Modify
list / Select from list / Vector transmitted diseases and you will find that our current selection
has been reduced to one disease.

This has been a long and complicated selection process to demonstrate the various criteria
for selection and methods of modification. We have selected all list A or B diseases that are
viral diseases of horses which can be transmitted by insect vectors and may occur in Spain. You
could arrive at the same selection in fewer steps (four) by starting with one of the more limiting
factors such as diseases transmitted by vectors, then selecting from that viral diseases of horses
reported in Spain.

After completing these tutorials we hope you will find your way around HandiSTATUS
without any trouble. However, if you need additional information on any item you can refer to
the Reference Section of this manual. We would appreciate receiving any comments or
suggestion you might have regarding the program itself or this documentation. Please send them
to the address listed under section 1.3, Obtaining a Copy of HandiSTATUS.
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REFERENCE SECTION

5 Select / Diseases

This is the first option in the Select menu. It is quite complex, and thus merits an entire
chapter. The remaining options under the Select menu are covered under Chapter 6: Other
Selections.

The Select / Diseases option allows you to create a current selection by searching the
disease database for diseases which possess certain characteristics. The use of this option is the
subject of Tutorials A (Individual Disease) and C (Group Selection). For new users, it is highly
recommended that these tutorials be followed.

5.1 Individual Disease

This is the simplest method to select a single disease. This option allows you to select
a disease, keyed by the common name, causal organism, or OIE/FAO code. The selection
window is divided into two columns: Disease Name, and OIE/FAO Code. You may switch
between the columns with < and . When the OIE/FAO Code column is highlighted, you may
perform an incremental search by disease code; when the Disease Name column is highlighted,
you may conduct an incremental search by the disease name. Tutorial A demonstrates how to
select a single disease and view the information on that disease which is contained in
HandiSTATUS.

Selecting a disease

The disease selections are made by pressing [Enter] when the name or code of a desired
disease is highlighted. You may move the cursor upwards and downwards through the list with
* and ¢, and the [PgUp] and [PgDwn] keys. Alternatively, you may use the incremental
search capability (see below). Once the highlighted disease has been selected by pressing
[Enter], you will be immediately taken to the View menu and the Names of the disease will be
displayed. From here you can "view" the various types of information about the selected disease
(see Chapter 7: View).

An individual disease selected in this manner is not saved in memory; that is to say it
does not become or replace the current selection.
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Incremental Search

This search mechanism has been implemented in several parts of HandiSTATUS. In
particular, when selecting diseases, or countries/regions, you may make the selection through
the incremental search mechanism.

Incremental search means that the searching process proceeds as you type the name or
code of the item you are searching for. For example, if you wish to locate Foot and Mouth
Disease, you may start typing the name: P, O, O, etc. Immediately, the cursor begins to
relocate itself in the list of items according to the characters you have typed. Deleting characters
(by pressing [BS]) backtracks through the list. To select Foot and Mouth Disease, you need
only type the characters FO; these two beginning characters correctly locate the desired disease.
Once the desired selection is highlighted, pressing [Enter] will make the selection.

Filtering the List by Language/Organism

Pressing (F2] to activate the sub-menu, and then selecting the Filter Setting menu
option will allow you to choose which common disease names appear in the selection window.
By default, the names in the default language are shown. You may choose to show any or all
of the English, French, and Spanish common names, as well as the names for the causal
organisms. This may aid in selecting a disease for which you know nothing but the French
name, or the causal organism, for example.

Place a check mark beside the type(s) of names which you wish to appear on the browse
list by highlighting the item and pressing [Enter]. The [Enter] key functions as a toggle key;
press it once to place a check mark and again to remove the check mark. Once the items you

~wish to select have been marked appropriately highlight Ready and press [Enter] to return to
the list of disease names.

Cancelling the Selection Process
To cancel the individual disease selection process, you may press [Esc] at any time.

Doing this will immediately return you to the Select menu, and any disease selection that existed
before you started the process will be restored.

5.2  Group Selection

This option allows you to select and/or modify a group of diseases based on various
criteria. Tutorial C demonstrates how to make and manipulate a group selection.
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After selecting Select / Diseases / Group Selection one of two things may happen. If
there is no current selection in memory you will be presented with the SELECTION METHOD
box and you may begin to make a new selection of a group of diseases based on certain
characteristics. The SELECTION METHOD box lists all of the criteria which you can use to
make or modify a selection of diseases (see section 5.3, The SELECTION METHOD Box). If
there is already a current selection in memory, then you will be presented with the List of
selected diseases and a choice of the following:

° Use list should be selected if in fact the current selection of diseases is the one you wish
to use; you wish to make no changes in the selection.

] New list allows you to begin a new group selection which will replace the current
selection.

° Modify list will allow you to make changes to the current selection, by adding records,
or deleting records by limiting the criteria for the records already selected.

®  Other allows you to save a group selection for future reference or to recall a group
selection which was previously saved to disk.

Below these headings there is a synopsis of the manner in which the present selection was
chosen. The first line shows which criteria that was used to make the main selection. An
additional line will be added for each modification stating the type of modification (see section
5.2.3 below, Modify list) and the criteria use for the modification (see section 5.3, The
SELECTION METHOD Box).

5.2.1 Use List

Choose this option if you wish to work with the group of diseases which has already been
selected. Pressing [Enter] while this option is highlighted will transfer you directly to the list
of selected diseases which has three columns: Record, Name, and Code. The first simply
enumerates the records in your current selection. The Name column contains the common name
of the disease in the language you have selected. The Code column contains the OIE/FAO Code
for the disease. You may move the cursor upwards and downwards through the list with * and
{, and the [PgUp] and [PgDwn] keys. Press [F2] if you wish to reactivate the previous list of
choices.

If you wish to view the information for one of the diseases in the list, highlight it and
press [Enter] and you will be immediately taken to the View menu and the Names of the disease
will be displayed. From here you can view the various types of information available on the
selected disease in the same manner as for an individual disease selection.

26

bd b4 b4 4 b4 b4 bd o bd bd bd b bed ] bed b b -

-~ b-d -



5.2.2 New List

You should choose this option if you wish to replace the current selection with a new

selection. It can also be used if you have made a mistake in your selection process and you wish
to start over. Once you have chosen one of the criteria in the SELECTION METHOD Box the
current selection will be erased completely and replaced with your new selection.

5.2.3 Modify List

This option allows you to manipulate the current selection in order to attain a list of

diseases that satisfy a particular set of criteria. After choosing one of the following operations
for selection, the SELECTION METHOD Box will appear offering a list of criteria for the
selection:

Select from list allows you to select a subset of diseases from the current selection
according to one of the criteria from the SELECTION METHOD Box (see section 5.3
below). The new selection will be selected from the records in the existing current
selection, instead of from the entire HandiSTATUS database. This usually results in a
reduction of the list; diseases in the current selection which do not satisfy the specified
criteria will be eliminated, and only the diseases which satisfy the specified criteria will
remain. For example, if the existing selection consisted of a list of diseases that affect
bovines, you might wish to select from this list only those diseases which are caused by
bacteria. Or, if you wish to have a list of diseases which affect both sheep and goats,
you would first select the diseases which affect sheep and then you would select from the
list only those diseases which also affect goats.

Add to list is a simple addition function. The diseases which satisfy the criteria you
specify will be added to the list. For example, if you wanted a list of all the diseases
which affected sheep or goats, you could first select all of the diseases which affect sheep
and then add to the list all of the diseases which affect goats. The new selection will be
merged with the existing current selection. For example, if a disease affects both sheep
and goats it will only appear in the list once. It'is important to realize that whatever
diseases fulfill the criteria to be added to the list will be added regardless of what
limitations were previously used to arrive at the current selection.

Delete from list will eliminate from the current selection those diseases which satisfy the
specified criteria. Notice that the select from list operation is complementary to delete
from list: the first allows you to restrict the current selection according to certain criteria
which the records must possess; the latter allows you to restrict the current selection by
specifying certain criteria which the records must not possess. The following is an
important example of when it is preferable to delete from the list rather than to select
from the list. Suppose you were interested to know all of the diseases which affect a
particular species that might possibly occur in Country X. You would start by selecting
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all of the diseases that affect that species. You would then have a choice of: 1) selecting
from the current selection only those diseases which have been reported to occur in
Country X; or 2) you could delete all of the diseases which had been reported not to
occur in Country X. What is the difference? If there were diseases for which Country
X did not report (blanks in the data) these diseases would not appear if you had chosen
the first option, but would be included in the list if you had chosen the latter, which is
the most conservative approach to arriving at a list of diseases which might possibly
occur in a given country.

o Insert individual name(s) will allow you to add an individual disease to the by using an
incremental search.

o Remove individual name(s) will allow you to delete any disease in the current selection,
just position the cursor on it and press the [Del] key. It will be immediately erased from
the current selection. To re-insert it (in the case you made a mistake deleting it), you
must know what the name was, and use the [Ins] key (Insert a new disease, above).

The above options can be used in combination to arrive at a current selection which fits
a highly specified set of criteria. Tutorial C gives an example of a complex selection process.
Once you have completed your desired selection you can then Use list to examine the
information available on the diseases in the current selection.

5.2.4 Other

Once you have made a selection, particularly if you used a complex set of criteria, you
may wish to save the current selection for future reference. This option allows you to save your
current selection or to recall a selection which was previously saved to disk.

In order to save the current selection, choose Write selection to disk and you will be
prompted for a filename. Enter a filename of up to eight characters. The file extension will be
added automatically (this will create two files, one with the extension DSL and another with the
extension MSL). If you wish to call up a selection that was previously saved, choose Read
selection from disk and you will be asked to enter the filename of the saved selection (without
an extension).

5.3 The SELECTION METHOD Box

You will have a choice of criteria from the SELECTION METHOD Box when you are
making a new group selection or after you have specified the manner in which you wish to
modify the current selection (select from, add to or delete from list). The following window
appears on the screen and allows you to incrementally build a current selection (which,
remember, is a collection of diseases):
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The following paragraphs explain the items in the Selection Method box pictured above.

5.3.1 Individual disease

This functions in the exact same manner as Select / Diseases / Individual disease (see
section 5.1), but here you can use this function in combination with the other criteria in the
SELECTION METHOD Box. It also allows you to build a current selection of individual
diseases by using Modify list / Add to list. For example, you might want to build a specific
list of the diseases which are exotic to your country. You could then find out which other
countries are also free from this list of diseases to identify possible sources of new genetic
material.

5.3.2 Type of disease organism

This option allows you to make selections according to the type of the causal organism.
Notice that there are three main heading (Virus, Bacteria/Fungi/etc., and Parasites). There are
more specific options available under bacteria, and several sub-groupings of parasites, which in
turn are sub-divided.

You may select either a main group, a sub-group or an individual item by moving the
cursor and pressing [Enter] when your preference is highlighted, or by pressing the hot-key
corresponding to your selection. For example, if you were to press number 3 you would select
all the diseases in HandiSTATUS which are caused by parasites. If you wanted to select all the
Helminths you should press §, but if you were only interested in nematodes, press n. To exit
without selecting anything, press [Esc].
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5.3.3 Vector transmitted diseases

This bption' allows you to select diseases which are transmitted by insect vectors. No
further input is required; the selection is modified according to the type of modification chosen
(see section 5.2.3, Modify list, for details).

5.3.4 Status (A,B,C)

This option allows you to select diseases according to the list to which they belong: List

A or B (common to both the OIE and FAO), or List C (FAO only). Their definitions are as
follow:

[ List A Diseases: Communicable diseases which have the potential for very serious and
rapid spread, irrespective of national borders, which are of serious socio-economic or

public health consequence and which are of major importance in the international trade
of livestock products.

° List B Diseases: Communicable diseases which are considered to be of socio-economic
and/or public importance within countries and which are significant in the international
trade of livestock and livestock products.

o List C Diseases: Communicable diseases with important economic influence at individual
production level.
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After you select one of the three choices, the current selection will be modified according
to the modification method chosen (see section 5.2.3, Modify list, for an explanation of
modification methods). For example, if you wish to select-both List A and B diseases, select
one of them as your initial selection then use Modify list / Add to list to add the other. Press
[Esc] if you wish to exit without making a selection.

5.3.5 Country or Region

This option allows you to select diseases which have a particular level of occurrence in
a specific country or region. For example, you may wish to know which diseases have been
reported to occur in Country X, or more speclﬁcally whxch diseases in Country X have been
reported to be enzootic.

. You are first presented with an incremental search which allows you to specify which
country you wish to work with. This window has two columns: Country name, and ISO Code.
You may switch between the columns using <« and -». You may use the incremental search to
find codes (in the right-hand column) or country names (from the left-hand column). See section
5.1, Individual Disease, for an explanation of the incremental search mechanism.

You may do an incremental search on any field (column) displayed. Thus, to select the
Andean region, whose ISO Code is 4L, you may either put the cursor in the left-hand column
and start typing Andean, or put it in the right-hand column and type simply 4L. Once you
have positioned the cursor to highlight the name or code of the country you desire to select
from, press [Enter). \

-Filtering Disease List by Occurrence

Next you will be presented with the disease occurrence filter menu. The purpose of this
filter is to limit disease selection according to the type of occurrence reported by the country.
This section describes the operation of this filter which appears in several HandiSTATUS
functions.

: Filter on:
Symbols Disease Occurrence
1.REPORTED
a. )( Ubiquitous
b. +++ High occurrence
c. ++ Enzootic
d. + Low sporadic occurrence
e (+) Exceptional occurrence
f. +.. Disease exists; distribution and occurrence unknown
g ! , Recognized in country for the first time
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2. QUESTIONABLE

h. ? Suspected but not confirmed

i. +? Serologiml evidence only, no clinical disease

j. <= Only in imported animals (quarantine)

k. ... No information available (excluding blank records)

3. CONFINED TO CERTAIN REGIONS
4. NOT REPORTED

L. - Not reported
m. 0000 Never reported
n. year Year of last occurrence

The main groupings of occurrence are indicated by the numerals 1 to 4: Reported;
Questionable; Confined to Certain Regions; and Not Reported. These are the same divisions
that are used for the maps. Pressing [Enter] while one of these options is highlighted will check
all of the sub-categories (indicated by lower case letters) of the main category. Pressing [Enter]
again will remove the check marks ([Enter] functions as a toggle key). Pressing [Enter] while
one of the sub-categories is highlighted will either remove or put a check mark (v) next to that
sub-category. You may also check individual items using the affiliated hot-key. The checked
items will be used to filter the list (or search or display) in which you are currently engaged.

Set the filter to limit your selection to only those diseases which match your specifications
(i.e., those which have been reported to have a specified distribution in the country you chose).
Place a check mark beside the desired code(s) then press O, for OK, to accept the settings.

The diseases with the occurrence code(s) you have specified, in the country you chose,
will be selected to modify your current selection. (If you are using Modify list / Delete from
list, the diseases which fit your criteria will be excluded from the current selection; in other
cases they will remain in the current selection.)

To cancel the selection process at any time, press [Esc]). If there is already a current
selection in memory it will not be modified.

5.3.6 Species/Commodity

This allows you to select diseases according to which species and commodity they affect.
You are first presented with a window containing a list of all the species in HandiSTATUS,
from which you must select one, either by using the arrow keys and [Enter], or pressing the
hot-key corresponding to the species entry. You may choose either a general species category
(MAMMALS, BIRDS, FISH or BEES), or a more specific species. If you select the general
species category, then all of the specific species under that category will be selected. For
example, selecting BEES is equivalent to selecting both adult bees and bee brood.

Note that the selection Other ruminants signifies ruminants other than bovine, caprine
or ovine (this message appears at the bottom of the screen). The options Other avian and
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Other fish include birds and fish, respectively, other than those that appear above these

selections.

Select View Print Im

Diseases
Ye SELECTION Species
Re| Type of diseas| 1. MAMMALS 3. FISH
Pr| Vector transmi a. Bovine n. Salmonidae
——| Status (A,B,C) b. Caprine o. Esocidae
- c. Ovine p. Cyprinidae
d. other ruminants q. Anguilla spp.
e. Equine r. Ictalurids
f. Swine s. Claridae
g. Leporine t. Other fish
h. Canine u. Molluscs
i. Wild fauna v. Crustaceans
2. BIRDS 4. BEES
j. Chicken w. Adult bees
i k. Duck X. Bee brood
i l. psittacines
g m. Other avian

After selecting a species, a commodity selection must be made in a similar fashion.
Again, there are general categories (LIVE MATERIAL, MEATS, PRODUCTS OF ANIMAL
ORIGIN), and specific sub-categories.

*t Utilities Quit

Diseases @
Ye SELECTION METHOD # o
Re| Type of di Commodity selection =———=ii
Pr| Vector tra| 1. LIVE MATERIAL i
| status (A, live animals #
Country or hatching eggs
Species/Co day-old avian species
Zoonoses semen or spawning prod.
Individual embryos/ova
2. MEATS
Read selec fresh meat

meat products

PRODUCTS OF ANIMAL ORIGIN:
human consumption
industrial use

animal feed
pharmaceutical use
pathological/biological
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The current selection will then be modified (see section 5.2.3 for an explanation of
modification type), according to the set of diseases occurring in the species and commodity
which you just specified.

To cancel the selection process, press [Esc] until you are returned to the SELECTION
METHOD box.
5.3.7 Zoonosis

This option allows you to select diseases which are zoonoses (infectious diseases common

to humans and animals). No further input is required; the current selection is modified
according to the type of modification you are doing, to include or exclude zoonoses.

5.3.8 Read selection from disk

This option allows you to recall a selection which was previously saved to disk. You will
be prompted to enter the filename of the saved selection. See section 5.2.4 for more details on
saving and recalling a selection.
6 Other Selections

This chapter covers the options that are available under Select with the exception of
Select / Diseases, which was the subject of the previous chapter.
6.1 Year

This option allows you to select data from a particular year. These data will then be used
in all features of the program until another year is selected; the maps will reflect the countries
for which information was reported in that year. In the present version there is only a choice
of data for 1990 or 1992. In future versions, data will be included for all years from 1989
inclusive.

6.2 Reports

This section will assist the user to fill out animal health reports to be sent to the
appropriate international organizations.
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6.3 Program Information

This selection contains credits to the individuals and organizations that have contributed
to the production of HandiSTATUS. You may activate a sub-menu from this screen by pressing
[F2]. The short-cut key [Alt-P] allows you to print the credit screen to a printer or file (see
Chapter 8: Print).
7 View

The View menu is used to retrieve detailed information about the current disease. If
there is no active selection, you are presented with a message window which informs you that
you must make a disease selection first. If there is a current selection, then you are presented
with a menu with three groups of related commands:

o The first command group is used to view general information about the current disease.
See the sections immediately following (7.1 to 7.6).

o The second group is used to view information concerning the geographic distribution of
the disease, including maps. See sections 7.7 to 7.10.

o The third group is used to move between diseases in the current selection (i.e., change
the current disease) or to change the current selection itself. See sections 7.11 to 7.13.
7.1 Names

This option displays basic information about a disease. View / Names is automatically
displayed after you have made a disease selection by various means:

o using Select / Diseases / Individual Disease
o selecting a disease from the List of selected diseases which can be accessed either under
View or when you are making a group selection (see section 7.13, List of selected

diseases).

o selecting a disease after doing an Import/Export analysis.
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The Names window appears as follows:

1 2 ’ 3 4 5 . 6 7

p=R@COr d=m==Cod Incubation=Transmission=Zoonosis=200-Code=
1/ 5 AO10 | v 21 days + - +
Causal Organism
Picornaviridae aphthovirus (RNA)
Common Names
English: Foot-and-mouth disease (FMD)
English: Foot and mouth disease
Frangais: Fidvre aphteuse (FA)
Espafiol: Fiebre aftosa (FA)

From left to right, across the top of the window, is the following information:

1. The position of the record in the current selection, and the number of diseases in the
current selection (the above example is the first disease in a list of five).

2, The OIE/FAO Code for the disease.

3. The type of causal organism (virus, bacterium, protozoa, etc.)

4. The incubation period of the disease as listed in the OIE’s International Animal Health

Code.

Whether the disease can be transmitted by insect vectors (+ is affirmative).

Whether the current disease is a zoonosis (+), or not (-).

Whether information on this diseases is available from the International Animal Health
Code (see section 7.3 to view the Code).

Now

Below this information is the scientific name of the causal organism (not to be confused
with the type code listed above). This is followed by a list of common names for the disease.
The English, Spanish, and French names will be present for all diseases; some diseases have
additional names preceded by the label Zooneses. These are the names of the disease when it
occurs in humans.

If the current selection consists of more than one disease it is possible to change the
current disease using the up and down arrows ( ¢ and ¢). This allows you to move sequentially
back and forth among the selected diseases.

Press [Enter] to pull down the options under View.

7.2  Status
Selecting this option will give you the definition of the OIE/FAO classification of the

current disease (List A, B, or C). See section 5.3.4 for the definitions. Pressing any key will
return you to the previous screen; then press [Enter] to pull down the View menu.
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7.3 International Animal Health Code

Selecting this item in the View menu will allow you to browse through the text from the
International Animal Health Code for the selected disease. In some instances the code is rather
long; you may use the [PgUp] and [PgDwn] keys to quickly move through the text, or ¢ and
4 to move line by line.

You may activate a menu for this optioﬁ by pressing F2 (as indicated on the screen),
which allows you to print the text.

To return to the View menu, press [Esc] or [Enter], and then press [Enter] when the
View menu item is highlighted in the menu bar.

7.4  Affected Species and Commodities

This item presents a display box with a list of the animal species and commodities which
can be affected by the current disease. After inspecting the list, pressing any key will close the
display box; then press [Enter] to pull down the View menu.

7.5 Disease Transmission

This option calls up a window which contains extracts from scientific journals and other
sources, regarding transmission of the current disease. This information was kindly provided
by the Australian Quarantine and Inspection Service. Once again, you can print this information
after activating the menu with [F2]. Press [Esc] or [Enter] to-close the window; then press
[Enter] to pull down the View menu.

7.6 Reference Laboratories

This option offers a choice of either FAO or OIE Reference Laboratories which
specialize in the current disease. A window will appear with the laboratory address (telephone,
fax, telex, and e-mail addresses as available) in the left part of the window, while the region
served appears on the right. Pressing any key will advance to the next laboratory; when the list
of laboratories has been exhausted, you will be returned to View. ,

7.7 Maps

This item allows you to view maps of the geographical distribution of the current disease.
It includes maps of the whole world or a specific region, annotated with symbols indicating
occurrence of the current disease for a particular species or all species.
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The Maps sub-menu allows you to choose a type of map:

World

Caribbean & C.America
South America

North America
Buropean Area

Africa

Asia

Oceania

Selecting World or one of the seven regions will draw a map of the disease occurrence
in animals. If the disease occurs in several species, you will be prompted to choose a particular
species, or a cumulative map (for all species for which information on this disease is reported).
For example, for Foot and Mouth Disease, which occurs in several species, the following
window appears:

bovinae (including buffalo)
buffalo

caprine

other

ovine

swine

Cumulative (for all species)

You may highlight the species you wish to include in the distribution map. Select the last
entry (Cumulative) to include all species. In this case the most serious level of occurrence will
be used to draw the map regardless of which species it was reported in. Press [Enter] to draw
the map. :

Map Symbols

On the maps, the occurrence in each country is indicated by a symbol. There are a set
of standard symbols which are used in disease reporting to the OIE and FAO. The actual
occurrence symbols which are reported by the countries and stored in the database have been
divided into four groups for mapping purposes. The following list summarizes the
correspondence between map symbols and reported occurrence:
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Map
Symbol Meaning Corresponding Occurrence Symbols
] Reported ) Ubiquitous '
+++ - High occurrence
++  Enzootic
+ Low sporadic occurrence
(+ Exceptional occurrence
+.. Disease exists; distribution and occurrence
unknown
! Recognized in country for the first time
? Questionable ? Suspected but not confirmed
- +? Serological evidence only, no clinical disease
<= Only in imported animals (quarantine)
No information available (excluding blank records)
# Restricted 0 Confined to certain regions’
o Not reported - Not reported

0000 Never reported
year  Year of last occurrence

Notice that the symbols on the right are the same as the one used to filter disease listings
by disease occurrence (see Filtering Disease List by Occurrence, under section 5.3.5, Country
or Region). '

It is important to note that no symbol will appear on the map for countries that did not
provide a report for the current disease in the selected year. This is not to be confused with
countries which reported "... No information available," which would appear as a question
mark on the map. '

7.7.1 World Map

The menu bar at the top of the screen in the world map contains the following options:
Regions

- Selecting this menu item will allow you to select a region from the world map, and draw
an expanded map of the selected region. For example, if after seeing the world map, you wish
to look more closely at the Caribbean and Central American regional map, you may select this
option by using the arrow keys to move the highlighted regional indicator, and pressing [Enter]
when the Caribbean/Central American region is highlighted. You will then be shown an
expanded map of this region, just as if you had selected this region instead of World from the
View / Maps sub-menu.
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Borders

This menu item works as a toggle. National borders are drawn in by default in accordance
with the active year. Selecting this menu item will remove the national borders so that you may
view the map uncluttered by political demarcations. Selecting it again will make the borders

reappear.
Shift World Center

This item allows you to shift the longitudinal axis of the world which HandiSTATUS places
in the center of the screen, thus effectively moving the position of the continents horizontally.
Use < and -» to position the new center, and press [Enter] (or [Esc] if you wish to cancel
without re-positioning the map). The map will be re-drawn. The new world center will be
saved in memory; to change it back to the way it was before you selected this menu item, you
must re-position the center once again.

There are two positions for the center which result in maps that do not cut the major land
masses in half. To position the center such that the Americas are on the left-hand side of the
screen, put the dotted line approximately on the border between Norway and Sweden. To
position it so that Asia, Africa and Europe appear on the left-hand side of the screen, position
the center exactly on the East coast of Australia and through Tasmania.

Print

Sends the map image to the printer. It is important that the right pﬁnter has been select
previously (see section 10.3).

Quit to Menu

Closes the world map and returns you to View /Maps.

7.7.2 Regional Maps

The Borders, Print, and Quit to Menu options function in an identical manner as for the
world map (previous section).

The World Map option replaces the regional map with a full world map of the requested
disease and species occurrence distribution.

The Country Names option displays the names of the countries for the active year.

Choosing country names again will clear the country names. The country names are not
displayed by default, to provide a clearer view of the map.
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7.8 Browse Distribution Listing

This option displays a list of all the countries and the information they reported for the
current disease and active year. The active year appears in the center, at the top of the box.
The columns display the country name; the species code; the occurrence symbols and the
symbols for the control measures that are in place.

If you are not familiar with these symbols, press [F2] to activate the menu. From here you
can highlight Occurrence Symbols and press [Enter] to view a list of the occurrence and
control symbols with an explanation of their meaning. You can scroll through the list using the
up and down arrows (* and ¢). You can also call up the list of symbols from the distribution
listing (without calling up the menu) by using the short-cut key [F3].

Browse
Search Country [Alt-S]
Occurrence Symbols [F3])

Species Codes (F4)
Set Filters [(F5)
Exit

Also from this menu you can select Browse to return to the distribution listing. You can
select Search Country to perform an incremental search for a specific country, or you can call
this feature up from the distribution listing by using the short-cut key [Alt-S].

The Set Filters function allows you to limit the browse listing to those countries which have
reported only certain types of occurrences (see set occurrence filter, under section 5.3.5,
Country or Region). For example, you might wish to list only countries that have reported that
they have the disease, or alternatively, you might be interested to know which countries have
reported that they do not to have the disease.

7.9 Yearbook-Type Listing

This option displays disease occurrence and control symbols in a format similar to the
FAO/OIE/WHO Animal Health Yearbook. First, you must select a country or region using an
incremental search, as explained in section 5.1, Individual Disease. The information reported
by the specified country for the selected disease and year is displayed for all of the species for
which that disease is reported. The listing for Foot-and-Mouth Disease in Venezuela in 1990
appears as follows:
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—=Record=s=Cod ype=Incubation=Transmission=Zoonos is-ZOO-COdOT
1/ 1 | mno10 v 21 days + - +

Causal Organism

Picornaviridae aphthovirus (RNA)

BOV BUF CAP ETC ovI Sul

Venezuela ++ - - - ++
PnQv PnQV
* *

If a region is specified, the listing will be made for each country in the region, spread over
several screens if necessary.

7.10 Zoonosis

} This item only contains information for diseases which are zoonoses (infectious diseases
common to humans and animals). You are given a further choice of whether you would like to
see the information in textual form or mapped.

7.10.1 Listing

This option will display a list of countries and the information they have reported regarding
occurrence of the selected disease in humans. The list is similar in format to that given by the
option View / Browse Distribution Listing, but contains only the country or region name, and
an occurrence symbol. The same occurrence symbols are used as for the normal listings, but
if it is known, the actual number of cases in humans is reported.

. Pressing F2 brings up the same menu as in Browse Distribution Listing, which allows you
to search for a country, view an explanation of the occurrence symbols or set the filter. There
is no need to view the species codes, as everything is this section applies to occurrence of the
disease in humans.

7.10.2 Map

This item and its menu options function in the same way as View / Maps, with the
exception that the data reported refers to occurrence of the disease in humans. Selecting this
option will draw a world map with appropriate symbols indicating where documented cases of
the disease in humans has occurred within the past year, as reported in the Animal Health
Yearbook. From the world map, you may choose the Regions option to obtain a regional map
of zoonosis occurrence. On the regional maps, as with Zoonosis / Listing, the actual number
of reported cases appears on the map when available. The world and regional zoonosis map
options are identical to those used for animal species maps (section 7.7: Maps).
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7.11  Previous Record

When there is a current selection that consists of more than one disease, this option allows
you to change the current disease to the previous disease on the list. You can also move
automatically through the list from View / Names by using the up and down arrows (* and ).

7.12  Next Record

When there is a current selection that consists of more than one disease, this option allows
you to change the current disease to the next disease on the list. You can also move
automatically through the list from View / Names by using the up and down arrows (* and ¢).

7.13  List of Selected Diseases

This menu item calls up the window listing the diseases in the current selection. Note that
this is the same window that appears when you are making a group selection of diseases through
Select / Diseases / Group Selection. It is used to browse through the current selection of
diseases, modify the list, or to designate the current disease, for which you can then view
detailed information. Section 5.2, Group Selection, explains the details of how to use,
manipulate or modify the List of selected diseases.

8 Print

This menu is used to generate a report about the current disease, or all of the diseases in
the current selection. There must be an active current selection to use this menu. From the
Print menu, indicate whether you wish to include the entire selection, or only the current
disease. You are then presented with the PRINT OPTIONS menu, from which you may select
various pieces of information about the disease(s) to be included in the report. The information
is similar to that which can be accessed from the View menu.

Pressing [Enter] when a desired item is highlighted will place a check mark (v) next to the
item if it is not checked, or remove the check mark if it is already checked (it functions as a
toggle key). The items Distribution/Occurrence and Zoonosis have sub-menus, from which
you can set the occurrence filter (section 5.3.5), and select a country via the incremental search
mechanism (section 5.1). After all the desired items have been checked, select the last item in
the menu, Ready, to generate the report.

You may send the report either to a printer, or to a DOS text file. If you choose to send
it to the printer, then it is sent immediately. If you choose to send it to a text file, then you are
prompted to enter the name of the file (ahlist.txt is the default name). You may wish to change
the device and path; for example, to save the file on a disk in drive A: in the sub-directory \text,
in a file named output.bak you would specify the filename A: \text\output.bak. This
creates an ASCII file which can be read into most word processors.
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9 Import/Export

9.1 Import/Export Analysis

This function is designed to generate disease selections which are of potential interest when
transporting animals or animal commodities between countries or regions. This is the subject
of Tutorial B.

The minimal input to the Import/Export Analysis function is a country of origin, and an
animal species. You may optionally specify an animal commodity, and/or a country of
destination. All of these items may be selected by moving the cursor to the appropriate line of
the Data Entry for Analysis window, pressing [Enter], then designating your choice in the
selection window which appears. For Animal Species and Commodity Type, the windows
contain entries which may be selected with the arrow keys and [Enter]. Country of Origin and
Importing Country are selected with the aid of an incremental search (section 5.1).

You may clear all of the specifications by selecting the CLEAR button. When all the
desired specifications have been made, the search process may be started by selecting the O.K.
button. The entire analysis process may be aborted by pressing the EXIT button (or by pressing
[Esc)).

After the search process is complete, a window appears listing any diseases which match
the specified criteria and which have been reported to occur in the country of origin. The
columns in the window are:

Code, Disease Name, Occurrence at Origin, Occurrence at Destination

The last two columns provide the comparative disease status for the exporting and importing
countries, which can aid the user in making a decision about the importation. The last column
will be empty if no destination country was specified in the Data Entry for Analysis window.
The symbols used are the same as those used for mapping and are explained in the legend below
the list of diseases. In all cases, the most recent disease status should be verified with the
country concerned.

To examine the information available on one of the selected diseases, press [Enter] when
any field of the disease is highlighted. You will be transferred to the View / Names function,
and may choose other View menu options as well. Once you have finished examining the
disease, you may press [Esc] a sufficient number of times to return to the Selected Records for
Risk Evaluation window, and select another disease for examination.

Pressing [Esc] from the Selected Records for Risk Evaluation window allows you to
return to the Data Entry for Analysis window. From here you may re-enter Import/Export
Analysis selection criteria or press [Esc] to exit this function and return to the main menu bar.
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9.2 Model Certificates

This option provides a choice of titles of the OIE - approved certificates. Pressing [Enter]
when the desired certificate is highlighted calls up a window containing a computer-formatted
model of the actual certificate. This model is as accurate as possible given the limitations of the
computer’s text display. In most cases, the differences between the model and the actual are
negligible. You can scroll through the page using the up and down arrows (* and +¢).

A note about "pages”

When viewing model certificates, the term "page” has two meanings. Since the size of a
page of paper is different from the size of a window on the computer screen, "real” pages and
"computer” pages do not coincide. The [PgUp] and [PgDn] keys may be used to change
computer pages (i.e., advance or regress one window-full of text); to advance to the next actual
certificate page (as it would appear on paper), the [Enter] key is used.

When viewing a particular certificate, pressing [F2] calls up a sub-menu from which you
may print the model certificate to a printer or to the disk; page through the certificate; view the
certificate (which simply exits from the sub-menu); or edit the certificate (which you may do
only if you supplied the correct password on the command line when you executed
HandiSTATUS).

10 Utilities

This menu contains options related to the presentation of data, the configuration of the
computer, and manipulating the format of data files.

10.1 Language: Change Default

This menu item allows you to change the operating language of HandiSTATUS. The
current possible choices are English, Spanish, and French. Simply highlight the language of
your choice and press [Enter].

10.2 Set Colors

This menu item allows you to change the colors which HandiSTATUS uses to display
various forms of data. You may choose the default settings for color or black-and-white display,
or you may customize your own colors or shades.

If you choose to select your own colors, you are presented with a full-screen menu from
which you may alter the current color settings. Initially, the right-hand side of the screen is the
active portion. From here, you may use the up and down arrows to select different options to
change. Pressing [Enter] when the desired option is highlighted will transfer control to the left-
hand side of the screen, which is the side where color selection takes place.

45




For most color settings, you must specify foreground and background colors. The
foreground is the color of the text, numeric or punctuation character; the background is the color
of the square on which the character is superimposed. The up and down arrows select different
color settings (indicated by the pointers). The left and right arrows transfer control between the
foreground and background menus. Notice that as you move the pointer up and down the
foreground and background selection menus, an example of the current color selection is updated
at the right-hand side of the screen. This is to verify that the color selection you have made is
correct (legible, desirable, etc.). When you have made the desired color selection, pressing
[Enter] will return you to the right-hand side of the screen.

When all of the desired color setting have been altered, you must press F10 while the
cursor is in the left-hand side of the screen to save the new settings. Beware: Pressing [Esc]
from the either side of the screen will exit and cancel any changes.

Below is an explanation of the various color settings which may be changed. The following
items refer to text and symbols inside pull-down menus. Note that menu-type entities inside
pop-up windows (for example, the Import / Export Analysis selection window) are not pull-
down menus.

® Horizontal bar. This is the color of the menu bar at the top of the screen.

® Box outline. This is the color of the boxes which surround pull-down menus and other
entities.

® Highlighted. This is the color of highlighted menu items in the menu bar and pull-down
menus.

® Selectable. This is the color of menu items in pull-down menus which the user is allowed
to select, currently.

® Non-Selectable. This is the color of menu items in pull-down menus which currently have
been made unavailable.

The following items refer to text which does not occur in pull-down menus. Note that this
category does include menu-type entities which appear inside pop-up windows, such as the
Import / Export Analysis window.

® Standard. This is the color of non-emphasized text.

® Inverted. This is the color of inverted (for emphasis) text.

® Intense. This is the color of, intensified text. Text becomes intensified when the menu
or window which it is a part of becomes active.

® Message. This is the color of message text. Help windows, and the windows which
appear to inform the user of search progress, etc., are message windows.

The following items refer to the color of graphics in the maps generated by HandiSTATUS.

Note that changing the background color specification for one of these items changes this
specification for ALL of them. The background color is merely the color of the water.
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® Coast lines. This is the color of the lines which identify the borders of continents and
islands with water.

® Land masses. This is the color of land masses (as opposed to water).

® Border Lines. This is the color of national borders within land masses.

® Reported. This is the color for the symbol used when the disease has been reported to
occur in a country.

® Questionable. This is the color of the symbol used when the presence of the disease in a
country has been reported to be questionable.

® Restricted. This is the color of the symbol used for countries that have reported that the
disease is restricted to a certain area.

® Absent. This is the color of the symbol used to identify countries which have reported that
the disease does not occur.

10.3  Select Printer

This option allows you to select what type of printer you have connected to your machine.
You may move the cursor using * and ¢, and the [PgUp] and [PgDwn] arrows, or you may
begin typing the make of your printer (it functions as an incremental search). When the desired
printer is highlighted, press [Enter] to select it. To cancel printer selection (i.e., to make no
changes), press [Esc]. Selecting the correct printer is essential to print distribution maps.

10.4 Browse Supporting Files

10.4.1 Animal Species

This option calls up a window displaying a list of all the animal species used by
HandiSTATUS. It is basically for reference purposes. There are three columns: Specode
(species code), Specname (species name), and Language.

The Specode column contains the text used to abbreviate species names. For reference,
here is a list of the different species recognized, in English only:

ANG Eels

API  Adult bees

AVI Avian (birds)

BOV Bovine (cows, bulls, etc.)
BRO Bee brood

BUF Buffalo

CAN Canine (dogs)

CAP Caprine (goats)

CML Camel
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CRU
CYp
DEE
DUC
EQU
ESO
ETC
FAU
FEL
HUM
ICT
LEP
MOL
oVl
PEL
PIS
PSI
RUM
SAL
SUI
VAR

The ETC category is used in the FAO/OIE/WHO Animal Health Yearbook when no species
is specified. This is usually used to report occurrence of the disease in other than the main

hosts.

The Specname column contains the name of the species in either English, French, Spanish,
or the scientific name for the species. The Language column contains the code of the language
of the Specname column. The codes used by HandiSTATUS are:

00
20
30
40

[F2] activates a submenu, which contains menu items for all of the actions available from

Crustaceans (crab, lobster, shrimp, etc.)
Carp

Deer

Duck

Equine

Esocidae (pike, etc.)

Other species

Wild fauna (mammals)

Feline (cats)

Humans

Catfish

Rabbit, hare

Molluscs (clams, oysters, mussels, etc.)
Ovine (sheep)

Fur-bearing animals (on farms)
Fish

Psittacid birds (parrots, etc.)
Ruminants

Salmon

Swine

Various species

Scientific name
English
French
Spanish

the Species window. A summary of these follows.

FILE sub-menu

Browse

This item exits the menu system and permits you to continue to scroll through the list of

animal species.
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Search [Al-S]
This menu item allows you to search for an animal species by name. You may activate this

option when the cursor is highlighting any of the three fields (Specode, Specname, or

Language), but the searching will always be by the species name (the Specname column).

When the window containing the prompt Search for = > appears, you should type the first
few letters of the species you are looking for, and press [Enter]. For example, to search for
the entry for "duck,” you might type the letters due, or alternatively canard (the word for
"duck” in French.) Press [Enter], and the window will scroll to the entry which matches your
input, or else a window will appear concisely informing you that your input does not match any
of the records in the database: "Not found ..."

Exit [Esc]
This entry will take you out of the Select / Animal Species menu, back to the menu bar.

EDIT sub-menu
This option is only available if you use the password for editing when you started the
program.

10.4.2 Countries and Regions

This option calls up a window displaying a list of all the countries and regions recognized
by HandiSTATUS. There are two columns: Isocode (International Standards Organization
Code), and Cname (Country Name).

An Isocode is a two-character code designating a geographical, political, or economic
region. Countries (and in some cases, parts of countries which are distinguished geographically
or politically) have a two-letter code (for example, Zimbabwe has the code ZW, Alaska has the
code AK, and the European part of Turkey has the code TE.) Super-national regions have
codes beginning with numerals. Following is a list summarizing the significance of the first

- character in these numerically-coded regions:

0 Entire world.

1 Europe

2 Asia (including Middle East)

3 Africa

4 Americas

5 Oceania (Australia, New Zealand, Pacific islands)

7 Other regions (including polar, religious, cultural, cross-regional)
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You may use the arrow keys, [Tab], [PgUp], and [PgDn] to move the highlighted cursor
between records and fields, as well as scroll the screen. As in the Select / Animal Species
mode, [F2] activates a sub-menu, which allows you to perform an incremental search. There
is one menu item which is unique to the Select / Countries mode, which is explained below.

The File / List areas sub-menu (activated by [F4], or by selecting this menu item) calls up
a window with two columns. The Sub-regions and Countries within column lists all the
countries and regions which are a part of the country or region highlighted by the cursor when
this menu item is selected. The Regions and Sub-regions column lists all of the countries or
regions which contain the currently highlighted country or region. For example, highlighting
the region Baltic States (whose ISO Code is 1I) and selecting the File / List Areas sub-menu
will result in the following lists:

Sub-Regions and Countries within Regions and Sub-Regions

Latvia Europe
Estonia Eastern Europe
Lithuania

That is to say, the Baltic States are Latvia, Estonia, and Lithuania; and they are located in
Europe and also in the more specific region, Eastern Europe.

10.4.3 Reference Laboratories

This option calls up a window from which you may view the addresses of the FAO
Reference Laboratories. The window is divided into two parts: the right side contains the
addresses; the left contains an alphabetical laboratory code. The code is merely for reference
by HandiSTATUS.

The cursor is initially in the right side of the window. Pressing [Esc] moves the cursor to
the left side, from where you may use the up and down arrows to move through the list of
laboratories. Pressing [Esc] again exits from this menu item.

10.5 Pack and Index Files

This option is really for the use of the programmer or other persons who make changes to
the files. It allows you to index various database files. Select a file to index using the arrow
keys or the hot-keys and press [Enter]. This functions as a toggle (press once to select, again
to un-select). You may cancel operations by highlighting the Cancel button and pressing
[Enter], or by pressing [Esc]. Keep in mind, however, that once a file is indexed, you can not
un-index it.
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10.6 Convert Occurrence Data

This option allows you to convert between dBase IIl - format and the internal,
HandiSTATUS-proprietary, binary format for the disease occurrence. You will mostly likely
not need to do this, but for those who wish to use the occurrence data in dBase format, the
conversion from bit-mapped to dBase III is available. The conversion back to bit-mapped has
been made unavailable for the distribution version.

11 Quit

You may exit HandiSTATUS after saving the current selection, or simply exit without
saving anything. It is important to note that if you exit without saving the selection, the next
time you run HandiSTATUS, there will be no current selection, that is to say, HandiSTATUS
will erase the current selection before exiting. Quit will always save the settings for language,
color and viewpoint of the world map.

12 Edit

This menu is "hidden" to the right of Quit. In order to access this menu, you must have
supplied the correct password on the command line when you executed HandiSTATUS. This
option in the menu allows you to modify any information HandiSTATUS contains about the
current disease, or add and delete diseases from the database. Instructions for editing
HandiSTATUS will be provided as needed to users who have also been given the password.
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Appendix I: Disease Codes

List A

A010
AO11
A012
A013
AO14
A015
A016
A017
A018
A020
A021
A022
A023
A030
A040
A050
A060

A070
A080
A090
A100
All0
A120
Al30
A150
Al160

Foot-and-mouth disease (FMD)

FMD - Virus O

FMD - Virus A

FMD - Virus C

FMD - Virus SAT 1
FMD - Virus SAT 2
FMD - Virus SAT 3
FMD - Virus Asia 1
FMD - Virus not typed
Vesicular stomatitis (VS)
VS - Virus Indiana

VS - Virus New Jersey
VS - Virus not typed
Swine vesicular disease
Rinderpest

Peste des petits ruminants

Contagious bovine
pleuropneumonia
Lumpy skin disease
Rift Valley fever
Bluetongue

Sheep pox and goat pox
African horse sickness
African swine fever
Hog cholera

Fowl plague
Newcastle disease

List B

- Multiple species diseases

B051  Anthrax

B052  Aujeszky’s disease

B053  Echinococcosis/Hydatidosis
B05SS  Heartwater

B0O58  Leptospirosis

B0S7 Q fever

B058  Rabies

" B05S9  Paratuberculosis
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B060 Screwworm (Cochliomyia
hominivorax)

Cattle diseases

‘B101  Anaplasmosis

B102  Babesiosis

B103  Bovine

B104  Bovine genital campylobacteriosis

BI05 Bovine tuberculosis
(Mycobacterium bovis)

B106  Cysticercosis (C. bovis)

B107  Dermatophilosis

B108  Enzootic bovine leucosis

B109 Haemorrhagic septicaemia

B110 Infectious bovine rhinotracheitis
(IBR/IPV)

Blll  Theileriasis

Bl112  Trichomoniasis

Bl113  Trypanosomiasis

Bl14  Bovine malignant catarrh

Bl115  Bovine spongiforme
encephalopathy (BSE)
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Sheep and goat diseases

B151  Brucella ovis infection

B152  Caprine and ovine brucellosis (B.
melitensis) _

B153  Caprine arthritis/encephalitis

B154  Contagious agalactia

B155  Contagious caprine
pleuropneumonia

B156 Enzootic abortion of ewes

B157  Pulmonary adenomatosis

B158  Nairobi sheep disease

B159  Salmonellosis (S. abortus ovis)

B160  Scrapie

Bl161  Maedi-Visna

Horse diseases

B201  Contagious equine metritis

B202  Dourine

B203  Epizootic lymphangitis

B204  Equine encephalomyelitis

B205  Equine infectious anaemia

B206 ' Equine influenza (Virus type A)

B207  Equine piroplasmosis (Babesiosis)

B208  Equine rhinopneumonitis

B209  Glanders

B210  Horse pox

B211  Infectious arteritis of horses

B212  Japanese encephalitis

B213  Horse mange

B214  Salmonellosis (S. abortus equi)

B215  Surra (T. evansi)

B216  Venezuelan equine
encephalomyelitis

Pig diseases

B251  Atrophic rhinitis

B252  Cysticercocis (C. cellulosae)

B253  Porcine brucellosis (B. suis)
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B254  Transmissible gastroenteritis of
 pigs ,

B255  Trichinellosis

B256  Enterovirus encephalomyelitis

B257 Porcine reproductive and
respiratory syndrome

Poultry diseases

B301  Avian infectious bronchitis

B302  Avian infectious laryngotracheitis

B303  Avian tuberculosis

B304  Duck hepatitis

B30S  Duck virus enteritis

B306  Fowl cholera

B307 Fowl pox )

B308 Fowl typhoid (S. gallinarum)

B309 Infectious bursal disease (Gumboro
disease)

B310  Marek’s disease

B311  Mycoplasmosis (M. gallisepticum)

B312  Psittacosis and Omithosis

B313  Pullorum disease (S. pullorum)

Lagomorph diseases

B351  Myxomatosis

B352  Tularaemia

B353 Viral haemorrhagic disease of
rabbits



Fish diseases

B401  Viral haemorrhagic septicaemia
B404  Spring viraemia of carp

B405  Infectious haematopoietic necrosis
B406  Herpesvirosis of salmonids

B408  Renibacteriosis

B411  Herpesvirosis of ictalurids

B413  Epizootic haematopoietic necrosis
B414  Edwardsiellosis (E. ictalun)

Mollusc diseases

B431  Bonamiosis

B432  Haplosporidiosis
B433  Perkinsosis '
B434  Marteiliosis

B435  Indovirosis

Bee diseases

B451  Acariasis of bees

B452  American foul brood
B453  European foul brood
B454 Nosemosis of bees
B455  Varroasis

Diseases of other animal species

B501  Leishmaniasis

List C
Multiple species diseases
C611  Listeriosis

C612  Toxoplasmosis
C613  Melloidosis

C614 Blackleg

C615 Botulism

C616 Other clostridial infections
C617  Other pasteurelloses

C618  Actinomycosis

C619 Intestinal Salmonella infections
C620 Coccidiosis

C621 Distomatosis (liver fluke)
C622 Filariasis

Cattle diseases
C652 Mucosal disease/Bovine virus
diarrhoea

C653  Vibrionic dysentery
C654 Warble infestation

Sheep and goat diseases

C701  Contagious pustular dermatitis
C702  Foot-rot

C703  Contagious ophthalmia

C704  Enterotoxaemia

C705 Caseous lumphadenitis

C706 Sheep mange

Horse diseases

C751 Equine coital exanthema
C752  Ulcerative lumphangitis
C753  Strangles

Pig diseases

C801  Swine erysipelas
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Poultry diseases

C851
C853
C854
C855

C856

Infectious coryza

Avian encephalomyelitis

Avian spirochaetosis

Avian salmonellosis (excluding
Fowl typhoid-B308 and Pullorum
disease-B313)

Avian Leucosis

Dog and cat diseases

C921

Canine distemper
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Appendik II: Occurrence Codes

DISEASE OCCURRENCE

0000 Never reported

- Not reported

year Year of last occurrence

? Suspected but not confirmed
(+) Exceptional occurrence

+ Low sporadic occurrence
++ Enzootic

+++  High occurrence

+?

Serological evidence and/or isolation
of causative agent, no clinical
disease

Disease exists, distribution and
occurrence unknown

Confined to certain regions
Ubiquitous

Recognized in country for the first
time

Only in imported animals
(quarantine)

No information available
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Appendix III: Control Codes

DISEASE CONTROL
(Control Measures)

Cn  Control of non-vertebrate vectors

Cr  Control of wildlife reservoirs

P Prohibition of import from infected
countries

Pa  Control program for only some areas
of the country

Q Quarantine, movement control and
other precautions at frontier and
inside the country

Qf  Quarantine and other precautions at
frontier

Qi Quarantine measures and movement
control inside the country

S Stamping-out policy

Sp  Modified stamping-out policy

T Treatment

te Testing

tv Voluntary testing

\Y% Vaccination

Vp  Vaccination prohibited

* Notifiable disease

Other Symbols

< Country without updated data

(published data are the same as in
previous issue; updating not received
in time)
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Appendix IV: Addresses

IICA

FAO:

OIE:

Inter-American Institute for Cooperation on Agriculture
Apdo. 55 - 2200 Coronado

Costa Rica
Tel: (506) 29-02-22
Pax: (506) 20-47-41

Food and Agriculture Organization of the United Nations
Via delle Terme di Caracalla '

00100 Rome, Italy

Tel: (39-6) 57971

Cables: FOODAGRI ROME

Telex: 610181 FAO I/ 625852 FAO I/ 625853 FAO 1
Fax: (39-6) 57973152 / 5782610 / 57975155

International (
12, rue de Pr
75017 Paris
France

Tel.:

Cables:
Telex:

Fax:

World Health
Avenue Appia
1211 Geneva
Switzerland
Tel.:

Cables:
Telex:

Fax:
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